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Publication history

June 2001
Standard, Release 4.00. This version introduces information about:

DMC8, and OTM DECT Manager. This version excludes retired DMC
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Meridian/Succession Companion DECT and the NTP number
553-3601-301.

This version replaces all previous versions.

June 1999
Standard, Release 3.00. This version introduces information about:

DECT Manager enhancements to the DECT Manager Connections, User
Administration, Login Module, System Parameter files, and DMC
addressing; the C4610 base station, and the C4010 handset. This
version also introduces changes that improve the on-line and
printed document.
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Standard, Release 2.00. This version introduces information about
Modem file administration.
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DECT Operation Administration and Maintenance Guide.
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About this guide

Target audience

The Meridian Companion DECT OA&M guide provides information for
planners, installers, site maintenance personnel, and
administrators. It contains administration programs and
maintenance information about the Companion system.

Identifying Nortel Networks PBX systems

The following systems are referred to in this guide as Large systems:

e Option 51
e Option 61
e Option 71
e Option 81
e Option 51C
e Option 61C
e Option 81C

The following systems are referred to as Small systems.

e Option 11
e Option 11E
e Option 11C

e Option 11C Mini

e Succession Communication Server for Enterprise 1000
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Call out boxes

CAUTION: Data loss

This symbol alerts you to a procedure that can result in a
loss of data.

CAUTION: Equipment damage

This symbol alerts you to a procedure that can result in
equipment damage.

CAUTION: Electrostatic sensitive device

This symbol alerts you to a procedure that can result in
equipment damage due to ElectroStatic Discharge (ESD).

CAUTION: Service interruption

This symbol alerts you to a procedure that can result in an
interruption of service.

> B P PP

DANGER: Electric shock

This symbol alerts you to the risk of a serious injury, or
death, caused by an electric shock.
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DANGER: Serious injury

This symbol alerts you to the risk of a serious injury, or
death, caused by an immediate hazard.

WARNING: Personal injury

This symbol warns you to the risk of a minor or moderate
injury caused by an immediate hazard.

NOTE
This symbol is used to indicate advice.

Step Action

1 This portion of the step action table details the required step.

This portion of the step action table details the action to carry out the
preceding step.

Meridian/Succession Companion DECT Operation Administration and Maintenance



Page 10 of 200 About this guide

553-3601-301 Standard 4.00 June 2001



Page 11 of 200

OA&M Introduction

This chapter contains the following topics:

Optivity Telephony Manager DECT Application. . ............... 11
DECT Applicationfeatures. .. ..., 12
Common ServicesfeatureS. . . ...t 12
OTM NaVigatorS . . .o ettt e e e e e e e 13

Features available to Windows based navigators
Features available to both Windows and Web based navigators.. 15

Optivity Telephony Manager DECT Application

The Optivity Telephony Manager (OTM) provides a single point of
access and control for managing various Meridian 1 applications.

OTM provides a DECT Application and OTM Common Services to
manage an MDECT system. OTM runs on Windows NT 4.0, Windows 98,
Windows 2000 as a server plus Windows 95 as client.

Note: For an overview of OTM, see Using Optivity Telephony
Manager for Meridian 1 (553-3001-330).
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DECT Application features

The DECT Application provides the following MDECT managing
features. The DECT Application allows you to do the following:

e launch the Application from OTM using Windows and Web
navigators

e view the MDECT System provisioning with the DECT Systems
window

e view the DMC8 configuration with the Boards window

e view base station configuration with the Radio Fixed Part
window

e view subscription information with the Subscriptions window
e upgrade Firmware using the DECT Systems window

e subscribe handsets using the Subscription window

e support DMC-8 and DMC (serial only)

e synchronize (update) the DECT Application database to the
MDECT system configuration when the OTM connects to the
MDECT system

e collect performance data using the Performance Collection
window

e view On-line Help
Common Services features

The following DECT management features are provided by the OTM
Common Services:

e OTM Alarm Management provides alarm collection and alarm
processing, and gives the following:

— Web based alarm browser used to view alarms, past alarms
and occurring alarms

— Windows based alarm browser used to view only those
alarms that occur while the browser is open
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— Alarm Notification application can notify you of an alarm
occurrence by pager, E-mail, and can forward the alarm to
an upstream processor

— PC Event log and Viewer used to view events and alarms
generated from the DECT Application in a report layout.

e Backup and restore lets you create an OTM backup file of the
DECT application data.

e User profiles allows you to configure different types of DECT
users.

e On-line help, provides help for common services features.

For more information about the Common Services features, see Using
Optivity Telephony Manager for Meridian 1 (553-3001-330).

OTM navigators

There are two navigators used with the DECT application to manage
an MDECT system:

e a Windows® based navigator
e a Web based navigator

Meridian/Succession Companion DECT Operation Administration and Maintenance
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A Windows based navigator, that uses the Microsoft Windows
interface, can access all DECT application features. A Web based
navigator, that uses the Web (http) interface, can access most, but
not all, DECT application features.

Use the Windows based navigator if you are managing an MDECT
system, at the keyboard and mouse of an OTM server.

You must use a Web based navigator if you are managing an MDECT
system from a client PC.

Features available to Windows based navigators

The following features are only available at an OTM server using the
Windows based navigator. The OTM server can:

e define MDECT system sites
e define Meridian 1 system

e configure handsets with the Station Administration
feature of OTM

e OTM Alarm Notification
e PC Event log and Viewer

e backup and restore the MDECT Manager database to and
from a file

e define a user profile for Windows based applications
e define user management for Windows based applications
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Features available to both Windows and Web based
navigators

Provisioning features The following provisioning features are
available using either a Windows based navigator or a Web based
navigator:

define MDECT system
MDECT system names
MDECT Concentration mode
MDECT system Access Right
Transmission parameters
DMC8 provisioning
Firmware provisioning

Base Station provisioning

Operation features The following operation features are available
using either a Windows based navigator or a Web based navigator:

MDECT system connectivity

MDECT system connection control

Read data from a MDECT system on demand

Define handsets with the overlays in the OTM database
Define handsets in the MDECT database

Subscribe handsets
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Maintenance features The following maintenance features are
available using either a Windows based navigator or a Web based
navigator:

e Operational status monitoring
e Alarm management

e Date and Time

e Upstream Manager IP address
e Basic browser

e MDECT system data synchronization with the MDECT Manager
database

e Performance
e PC Event Log

Security features For information about the Security features, see
Using Optivity Telephony Manager for Meridian 1 (553-3001-330).
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MDECT System administration

The following index is a navigator for this chapter:

A
Access security
Web based navigator 135
Windows 137
access to the DECT application
Web base navigatoe 22
Windows 19
Add
MDECT Systems 31
C
Change
date 125
IP address on MDECT System DM C8 Relay card 119
IP address on the OTM 117
MDECT System name 115
parameters 127
PARI 121
passwords 113
SARI 121
time 125
Upstream manager |P address 123
Configure
concentrated handsets 61
non-concentrated handsets 53
Connection to an MDECT system 28
D
Delete
MDECT Systems 51
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K
Keep
non-operational base stations 131
non-operational DMC8 fromOTM 129
)
Open
Boards window 27
RFP window 27
Subscriptions window 27
OTM data 105
P
Permanent connection to an MDECT system 29
provision
remote DM C8 customer has DECT Manager 107
remote DM C8 no customer DECT Manager 109
R
remove
non-operational base stations from OTM 131
non-operational DMC8 from OTM 129
Resolve a subscription configuration mismatch 133
S
subscription
C401075
C4010 EX 75
C4020 75
C4050 82
copy 90
disable 87
export 101
find 96
force disable 103
import 98
move 93
remote customer has DECT Manager 112
remote customer no DECT Manager 110
u
Update 105
MDECT System data 105
W
Web based navigator 22
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Windows access to the DECT application

For access from a Web based navigator, see “Web based navigator
access to the DECT application” on page 22.

Login to the OTM

Figure 1:
OTM login dialog box

OTM Login E|
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R s
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Table 1 Login to the OTM

Step Action

1 Access the OTM Login dialog box.

Click on Start>Programs>0TM.

2 Login.

Enter your User ID, Password, and click OK.
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Select the Meridian 1 PBX that supports
the MDECT system

Figure 2:
OTM Navigator window
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Table 2 Select the Meridian 1 PBX that supports the MDECT system

Step Action

1 Select the Meridian 1 system.

Double click on XXX (shown as Sample System in Figure 2).
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Launch the DECT Application

Figure 3:
M 1 System Window
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Table 3 Launch the DECT application

Step Action

1 Launch the DECT application.

Double click on DECT, or pull-down Eile menu and click DECT.
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Web based navigator access to the
DECT application

For more detailed information on Web based navigators, see Using
Optivity Telephony Manager for Meridian 1 (553-3001-330).

Open the Web Administrator Login

Table 4
Internet Explorer and Netscape Communicator

Internsk
Explorer

Comnrnuricakor

Table 5 Open the Administrator Login

Step Action

1 Open a Web browser.

Click on Internet Explorer icon or Netscape Communicator icon.

2 Open the Administrator login screen.

Enter the URL http://<otm_server_name>/admin or use the ip_
address.

553-3601-301 Standard 4.00 June 2001



MDECT System administration Page 23 of 200

Web Administrator Login

Figure 4:
OTM Web Administrator login
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Table 6 Open the Administrator Login

Step Action

1 Select the Administrator Login.

Click on the applet launch logo.

2 Login.

Enter your User Login, Password, and click Submit.
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Open the Web current Status

Figure 5:
OTM Web navigator current Status

ﬂ;:m_

e bl Vew [ Coewwecsls  Hep

o " stz K ...::-—-||l-: A4 R B B i rvagasion Mwri g E ngtded sl sep 7 ezl Lab 4 e 1211 | cEHELT M Dol i

a »#«» 3 % a2 £ 3 & 1

. bsi Rakind W  Gamch  Guiie Enuariy
% Fewen W imsicens Mo nCodmenst W ESP L DM W p0RPPees 1 P o it W edPles o Ll Vs

* T i polailiziigl
-
O/ SinmmPepor |
e — Huscrigiing Curned Staium

OTWA Pkl B Waigiar 11033

Lagi wwyin FHA ES1-1 PM

i e ¢ DT Soorer Bl aeiom
po Dula Bafwrng And Asce Searta
y DECT Jvk Snamail
h L CiTH Feund Savvics SEartad
x : _— T Fosmiais Snamad
S ynsare Soandy SEarsard
.-""" e Tearranad Soawei Snamail
g o Masinr Haried
M =
5 MhFF b of g W UEEre 15

Table 7 Open the current Status

Step Action

1 Open System Navigator screen.

Click on System Navigator in the Equipment list on the left.
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Open the Web System navigator

The System navigator is selected by clicking on System Navigator
from the list on the left of the previous screen.

Figure 6:
OTM Web system navigator
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Table 8 Open the Web System navigator

Step Action

1 Select an MDECT system.

Highlight a system in the Systems list.

2 Open the DECT systems window.

Click on OTM DECT in the grey box on the left.
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DECT Systems window

Figure 7:
DECT Systems window
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Table 9 Open Subscriptions, Boards, and RFP windows

Step Action

1 Select an MDECT system.

Highlight a system from the list.

2 Open one of the following from the DECT Systems window:
e Subscriptions window

e Boards (DMC) window

* Radios (base station) window

Click on the appropriate entry in the Applications pull-down menu.
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Connection to an MDECT system

Table 10 Connection to an MDECT system

Step Action

1 Select an MDECT system from the DECT Systems window list.

Highlight an MDECT system.

2 Activate one the following from the DECT Systems window:
1 connect to an MDECT System

2 disconnect from an MDECT System

3 lock a connection to an MDECT System

4 unlock a connection from an MDECT System

From the Applications pull-down menu click on the following items, or
click on the following icon:

1 Connect or G} (green)
+4
2 Disconnect or O} (yellow)
v
i
3 Lock or || (red)

4 Unlock or EJIE (yellow)

Note: See DECT Systems window in Meridian/Succession Companion
Overview (553-3601-103) for a description of connections.

NOTE

While the Connection status is Connecting or Disconnecting the
Connect/Disconnect tool is disabled. The status bar shows the
connection progress.
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Permanent connection to an MDECT system

Figure 8:
DECT Systems window and DECT System Properties dialog
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Table 11 Permanent connection to an MDECT system

Step Action

1 Select an MDECT system from the DECT Systems window list.

Highlight an MDECT system.

2 Connect to an MDECT System.

From the Applications pull-down menu, click on Connect or click on
the @ (green) icon.
S

3 Open the Properties dialog.

From the File pull-down menu, click on Properties.

4 Select Permanent Connection.

Click on the Permanent Connection box.

5 Accept the changes.

Click on the OK button.
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Add MDECT systems

Add new site properties

Figure 9:
New Site Properties
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Complete the following steps:

Table 12 Add new site properties

Step Action

1 Open the New Site Properties dialog.

In the OTM Windows Navigator, choose Add Site from the Configura-
tion menu.

2 The Site Name appears in the Navigator tree. The Short Name is an
abbreviated site name that displays in the Alarm Banner.

Enter the Site Name and Short Name.
Note: Bold fields in the dialog sheets indicate required information.

3 The Site Location box.

Enter your Site Location information.

4 The Contact Information box.

Enter the contact name and related information, and click Apply.

5 To add a new system to this site.

Click Add System.

6 When you have finished entering Site information, click one of the fol-
lowing buttons to add the site to the Navigator tree.

OK adds the site and closes the property sheet.

Apply adds the site and leaves the property sheet open allowing you to
add another system to this site (you may repeat step 5 to add another
system)

Cancel closes the dialog box without adding the site.
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Add your Meridian 1 PBX on the OTM server

You can add as many systems (including non-Meridian 1 systems) to
a site as your license permits. You must have administrator
privileges to add a system.

Figure 10:
Add System

Add System
System Type
i ok
Cancel
Help

Complete the following steps:

Table 13 Add your Meridian 1 PBX on the OTM server

Step Action

1 In the Navigator window, select the site.

If you are adding a new system from within the New Site Properties
window, skip to step 3 in this procedure.
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Table 13 Add your Meridian 1 PBX on the OTM server

Step Action

2 Open the Add System dialog.

Choose Add System from the Configuration menu or the right
mouse button pop-up menu.

3 Program the Add System dialog box.

You may need to install additional software to enable other system
types not listed here. Follow the installation instructions included with
your order.

Select the system type, and then click OK.
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Add your Meridian 1 PBX properties - general

Figure 11:
New System Properties - General
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Complete the following steps:

Table 14 Add your Meridian 1 PBX properties - general

Step Action

1 Select the General tab.

Click the System Properties—General tab.

2 Program the System Name and Short Name (required fields), and
other information as needed.

Enter the System Name and Short Name.

3 You can make System Location and Contact Information the same as
site information.

Click the Same as Site checkbox.

4 Accept changes.

Click the OK button.
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Add a communications profile for the DECT application

Figure 12:
Add Communications Profile
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Complete the following steps:
Table 15 Add new Meridian 1 PBX communications profile

Step Action

1 In the Navigator window, select the Sample Site.

Double click on Sample Site.

2 Choose the Properties dialog.

Click on Properties from the File menu.

3 Open the Add Communications Profile dialog.

Click on the Communications tap and click Add.

4 Select a communications type.
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Table 15 Add new Meridian 1 PBX communications profile

Step Action

Highlight Ethernet in the Type box.

Note: The DECT application does not use the Communications Profile.
Unless there is another application that requires a specific
Communications Profile, choosing Ethernet is the least complicated
profile to implement.

5 Program the Profile Name.

Enter a Profile Name.

6 Accept the changes.
Click OK.
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Add your Meridian 1 PBX System Data Properties

Figure 13:
System Properties - System Data
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Complete the following steps:

Table 16 Add your Meridian 1 PBX System Data Properties

Step Action

1 Select the system Data tab.

Click the System Properties—System Data tab.

2 Program the Machine Information.

Enter the Machine type and Release version for the system.

Note: For example, if your Meridian 1 is an Option 61C running X11
Release 25 software, enter 61C in the Machine field and use the drop
down box to select 25 in the Release field.

3 Program the System Parameters.

Enter the appropriate values for your system.

4 Program Packages.

Enable or disable M1 packages as appropriate for your system.

5 Note: You can copy this data directly from an installed switch by
scheduling an upload with the File menu Update System Data command
in the System window. Update System Data uses the communication
profile for Station Administration. However, configure the Release
number here first to allow available applications to show up properly in
the Applications Tab.

553-3601-301 Standard 4.00 June 2001



MDECT System administration Page 41 of 200

Add your Meridian 1 PBX System Applications
Properties

This tab defines the OTM applications that will appear in the System
window and the communications profile to be used with each
application. You must enable an application for it to be available in
the System window.

Figure 14:
System Properties- Applications
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Complete the following steps:

Table 17 Add your Meridian 1 PBX System Applications Properties

Step Action

1 Select the system Applications tab.

Click the System Properties—Applications Data tab.

2 To enable an application.

e Select the application in the Applications box.

e Selecta Communications Profile from the drop-down list in the
Selected Application box.

e A checkmark appears next to the application and the Enabled box is
also checked.

3 To disable an application.

e Select the application in the Applications box.

* Inthe Selected Application box, click the Enabled checkbox to
remove the checkmark.
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Add your Meridian 1 PBX Customer Properties

This tab lists the customers currently defined for this Meridian 1
system. You may add new customers, delete customers, or review the
properties of a selected customer. When you add a new customer,
you configure the Meridian 1 features and numbering plans that are
available to the customer. This information it is not automatically
updated on the Meridian 1 and must be updated by using LD15
customer data block.

NOTE
Customer information is required for System Administration/CPND

and ESN applications.

Figure 15:
System Properties - Customers
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Complete the following steps:

Table 18 Add your Meridian 1 PBX customer properties

Step Action

1 Select the system Customers tab.

Click the System Properties—Customers Data tab.

2 Select a customer number.

Click OK.

3 Update the Meridian 1 PBX.

Use LD 15 Customer Data Block.
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Add your Meridian 1 PBX Customer0 General Properties

Figure 16:
CustomerO Properties - General
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Complete the following steps:

Table 19 Add your Meridian 1 PBX Customer0 General Properties

Step Action

1 Select the General tab.

Click the General tab.

2 Program the Customer Name and Number.
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Table 19 Add your Meridian 1 PBX Customer0 General Properties

Step Action

Enter the Customer Name and Number.

3 Program the Home Location Code.
Enter the HOLC as defined in LD 90.

4 Program the Scheduler System ID, if you are using applications with
scheduled activities, such as Station Administration/CPND, ESN, and
Traffic.

5 Accept changes.

Click Apply.
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Add your Meridian 1 PBX CustomerO Features
Properties

Figure 17:
Customer Properties - Features
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Complete the following steps:

Table 20 Add your Meridian 1 PBX Customer0O Features Properties

Step Action

1 Select the Features tab.

Click the Features tab.

2 Program Features Group.
3 Accept changes.
Click Apply.
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Add your Meridian 1 PBX Customer0O Numbering Plans

Properties
Figure 18:
Customer Properties - Numbering Plans
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Complete the following steps:

Table 21 Add your Meridian 1 PBX Customer0 Numbering Plans Properties

Step Action

1 Select the Numbering Plans tab.

Click the Numbering Plans tab.

2 Program the customer information appropriate for your Meridian PBX.

3 Accept changes.

Click one of the following buttons to save the information:
e OK adds the customer and returns to the System properties sheet.

e Apply adds the customer and leaves the Customer properties open
so that you can add other information for this customer.

e Cancel closes the dialog box without adding the customer.

NOTE
At this point the DECT application is installed in the OTM server.
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Delete MDECT systems

Figure 19:
DECT Systems window
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Table 22 Delete MDECT systems

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.
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Table 22 Delete MDECT systems

Step Action

3 Select an MDECT System to delete.

Highlight an MDECT system from the list.

4 Delete the MDECT System.

From the File pull-down menu, click on Delete.
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Configure non-concentrated handsets on a
Meridian 1 PBX

For information about System Administration, see Using Optivity
Telephony Manager for Meridian 1 (553-3001-330)

Open Station Administration window

Figure 20:
M1 System Window
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Table 23 Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the M 1 System Window.
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Access Add Station dialog

Figure 21:
Station Administration window
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Table 24 Access Add Station dialog

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.
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Add 500 analog standard

Figure 22:
Add Station dialog
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Table 25 Add 500 analog standard

Step Action

1 Add 500 analog standard.

Highlight 500 Analog Standard, and click on the OK button.
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Access features

Figure 23:
500 dialog
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Figure 24: Access features

Step Action

1 Access features.

Click on the Features button.
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Access wireless type

Figure 25:
Features dialog
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Table 26 Access wireless type

Step Action

1 Access wireless type.

Highlight Wireless Type, and click on the Select button.
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Select wireless type

Figure 26:
Wireless dialog
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Table 27 Select wireless type

Step Action

1 Select wireless type.

From the Wireless Type (WTYP) pull-down menu, click on YES.
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Select DECT wireless set

Figure 27:
Wireless dialog
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Table 28 Select DECT wireless set

Step Action

1 Select DECT handset.

From the Wireless Type (WTYP) pull-down menu, click on DECT Wire-
less Set, and click on the OK button.
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Accept changes

Figure 28:
Features dialog
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Table 29 Accept changes

Step Action

1 Accept changes.

Click on the Done button.
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Configure concentrated handsets on a
Meridian 1 PBX

Open Station Administration window

Figure 29:
M1 System Window
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Table 30 Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the M 1 System Window.
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Access Add Station dialog

Figure 30:
Station Administration window
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Table 31 Access Add Station dialog

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.
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Select Digital Cordless Set

Figure 31:
Add Station dialog
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Table 32 Select Digital Cordless Set

Step Action

1 Select Digital Cordless Set.

Highlight DCS, and click on the OK button.
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Select Features

Figure 32:
DCS dialog
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Table 33 Select Features

Step Action

1 Select features.

Click on the Features button.
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Select wireless type

Figure 33:
Features dialog
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Table 34 Select wireless type

Step Action

1 Select wireless type.

Highlight WTYP, and click on the Select button.
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Select Visit or local

Figure 34:
Wireless dialog
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Table 35 Select Visit or local

Step Action

1 Select Visit if this handset is to visit this Meridian 1 PBX or select local
if this handset is configured on this Meridian 1 PBX.

If Visit, go to step 2. If local, go to step 4.

2 Select visit.

From the Visiting DECT Set (VSIT) list, select Yes.

3 Select a Home DN.

Enter a DN in the Home Directory Number (HMDN) box.

4 Select local.

From the Visiting DECT Set (VSIT) list, select No.

5 Accept changes.

Click on the OK button.
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Select an index

Figure 35:
Features dialog
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Table 36 Select an index

Step Action

IR

Select an index.

Highlight INDX, and click on the Select button.
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Provision hardware

Figure 36:
Hardware Provisioning dialog
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Table 37 Provision hardware

Step Action

1 Select a DMC TN.

Enter a TN in the DECT Mobility Controller (DMC) box.

2 Select an index.

Enter an index in the Index on DMC (INDX) box.
(Index range is 0 to 509.)

Note: The Terminal Number (TN) is a virtual TN and is selected by the
Meridian 1 PBX system.

3 Accept changes.

Click on the OK button.
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Accept changes

Figure 37:
Features dialog
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Table 38 Accept changes

Step Action

1 Accept changes.

Click on the Done button.
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Single line features

Figure 38:
500 dialog
e - |
i i i (1] 4
| | E.“'-'-h'ﬂl | 0 'rl

| Looabon

Teaminal Humbis

4]

; — | . .
a - | _'I_I ln....-.m.Jﬂ _——
S | Cea | CLID Entry

|—| Hupt 1o

Table 39 Single line features

Step Action

1 For other single line features.

Refer to the OTM Station Administration in Using Optivity Telephony Man-
ager for Meridian 1 (553-3001-330).
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Retrieve subscription data for handsets

Figure 39:
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Complete the following steps:

Table 40 Retrieve subscription data for handsets

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the Subscriptions window.

Follow the instructions on, page 27.

4 Retrieve the subscription configuration data from the OTM Station
Administration database.

In the Subscriptions window, click on the Operations pull-down menu,
click on Retrieve OTM Configuration.

5 Note: At this point, all handsets configured on OTM Station
Administration are shown in the Subscriptions window

Open the Configure DECT Subscription dialog.

Click on the Eile pull-down menu, click on Add or click on =1
#

=
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Enable subscription

Figure 40:

Subscriptions window
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Complete the following steps for each handset:

Table 41 Enable handsets

Step Action

1 Note:
window.

Select a handset from the list.

At this point, there are no PINs shown in the Subscriptions

Click on one handset in the list to highlight a row.

2 Enable handsets.

Click on the Operations pull-down menu, click on Enable or click on

-4 @
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Activate the PIN on the handsets

Figure 41:
Subscriptions window
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Complete the following steps:

Table 42 Obtain the PIN

Action

3 Note: At this point, in the Subscriptions window, the PINs are shown
and the Status is Enabled.

Subscribe the C4010, C4010Ex, C4040, and C4050 handsets.

See “C4010, C4010 Ex, C4020 handset subscription” on page 75,and “C4050 hand-
set subscription” on page 82.

NOTE
When a handset is subscribed, the Subscription window shows the
Status column as Subscribed and does not show a PIN.
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C4010, C4010 Ex, C4020 handset subscription

Figure 42: C4010 handset and C4010 Ex handset
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Distribute C4010, C4010 Ex, C4020 handsets and install
battery chargers

Consult your work order for a list of handset users and their
locations.

DANGER: Serious injury
Never charge a C4010Ex battery in an explosive atmosphere.
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Figure 43: Battery details, charger details, and connections
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Table 43 Install battery charger and charge batteries

Step Action

1 Take the handset package to the user location.

2 Unpack the handset and its accessories, as applicable.
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Table 43 Install battery charger and charge batteries

Step Action

3 Insert the handset battery pack, as applicable.
Note: Use only the approved battery for the C4010 Ex handset.
4 Unpack the handset battery charger and its accessories.
5 Mount the battery charger.
Place the charger on the desk, or mount the charger on the wall,
as applicable.
Note: Never mount a battery charger in an explosive atmosphere.
6 Install the mounting screws. Use screws with a maximum diameter of
4 mm.
Turn the two screws into the wall at a distance of 45 mm from each
other. Make sure that the screw heads protrude by 2.5 to 3 mm.
7 Hang the charger on the screws.
8 Install the power supply.
Plug the power supply cable into the connector located on the side of
the charger, then plug the ac adapter into the 230 V ac mains socket.
9 Place the handset into the charger.
Note: The battery icon appears on the display indicating the battery is
charging, if the battery is installed or not.
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CAUTION: Service interruption

Charge the C4010, C4010 Ex, C4020 battery at least 12 hours
before using the handset for the first time. This will lengthen
the service life of the battery.

Subscribe the C4010, C4010 Ex, C4020 handset

Consult the work order for a list of subscription names.

Table 44 C4010, C4010 Ex, C4020 handset subscription

Step Action

1 Select Language.

2 Select Declare base.

Press the Declare base key.

3 Declare base number? 12345678.

Press the Ok key.

4 Enter code refers to the PIN code.

Note: The Subscriptions screen displays the PIN. The PIN is only valid
for 16 minutes.

Enter the PIN.

To delete the last digit you entered, press Erase or select the digit and
enter a new digit.

Press the Ok key.
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Table 45 Handset name and DN identity

Step Action

5 Select Menu.

Press the Menu Kkey.

6 Select Handset name.

Dial 86.

7 Enter the Handset name and/or the handset DN to identify the hand-
set.

To enter a character, press keys 0 to 9 as shown in Table 46. For exam-
ple to enter E press key 3 twice. To move to the next character, pause
three seconds. To delete a character, press Erase or select the digit
and enter a new digit.

Note: Handset DNs are programed in LD 10, not in the DECT database.

8 Confirm the name and DN.

Press the Ok key.
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Table 46 Southern handset key pad alphabet equivalent

e English

e French

« German

e Dutch

e Spanish

« ltalian

Key 1 2 3 4 5 6

0 0
1 - / space 1 :
2 A B C 2 A
3 D E F 3 E E
4 G H I 4 | |
5 J K L 5
6 M N @) 6 N ¢) ¢
7 P Q R S 7
8 T U v 8 U U
9 W X Y z 9
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Table 47 Northern handset key pad alphabet equivalent

e English
+ Portuguese
e Swedish
¢ Norwegian
*  Finnish
e Danish
Key 1 2 3 4 5 6 7 8 9
0 0
1 - / space 1 : : o
2 A B C 2 A A A A i
3 D E F 3 E
4 G H | 4
5 J K L 5
6 M N @) 6 ¢ O ¢
7 P Q R S 7
8 T U v 8 U
9 W X Y z 9
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C4050 handset subscription

Figure 44: C4050 handset
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Distribute C4050 handsets and install battery chargers

Consult your work order for a list of handset users and their
locations.
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Figure 45: Battery details, charger details, and connections
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Table 48 Install battery charger and charge batteries

Step Action

1 Take the handset package to the user location.
2 Unpack the handset and its accessories, as applicable.
3 Insert the handset battery pack, as applicable.

Note: Use only the approved battery for the C4050 handset.

4 Unpack the handset battery charger and its accessories.

5 Mount the battery charger.

Place the charger on the desk.
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Table 48 Install battery charger and charge batteries

Step Action

6 Install the power supply.

Plug the power supply cable into the connector located on the side of
the charger, then plug the ac adapter into the 230 V ac mains socket.

7 Place the handset into the charger.

Note: The LED ring on the handset shows green when the batteries are
charging.

(H

CAUTION: Service interruption

Charge the C4050 battery at least eight hours before using the
handset for the first time. This will lengthen the service life of
the battery.

Subscribe the C4050 handset

Consult the work order for a list of subscription names.

Table 49 C4050 handset subscription

Step Action

1 Select Menu.

Press Menu.

2 Select System.

Scroll to System. Press OK.
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Table 49 C4050 handset subscription

Step Action

3 Select Subscription.
Press OK.

4 Select Options.
Scroll to New. Press OK.

5 Enter PARK if two DECT systems overlap.
Press OK.

6 Enter the PIN code.
Note: The Subscriptions window displays the PIN. The PIN is only valid
for 15 minutes.
Enter the PIN code.

7 Enter the system name.

8 Enter the handset DN.

9 Enter the handset users name.

Meridian/Succession Companion DECT Operation Administration and Maintenance



Page 86 of 200 MDECT System administration

Table 50 Handset key pad alphabet equivalent

Key 1 2 3 4 5 6 7 8 9 10 11

0 0 space | @ $ &

1 1 ? ! , ; “ ‘

2 A B C 2 A A £ c

3 D E F 3 E E E E

4 G H | 4 | | ] |

5 J K L 5

6 M N 0 6 N o) 0 o 0 0 @

7 P Q R S 7

8 T U \Y 8 U U U U

9 W X Y z 9

w & - + = ~ < > R %

# # ( ) { } [ ] / \ _
NOTE

Complete the Meridian 1 COMPANION Programming Records
(553-3601-250).

553-3601-301 Standard 4.00 June 2001



MDECT System administration Page 87 of 200

Disable a handset subscription

Figure 46:
DECT Subscriptions window and Disable DECT Subscription dialog
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NOTE

See the following for explanations, “Disable subscriptions” on page
103 in Meridian/Succession Companion Overview
(553-3601-103).

“Multi Site Mobility Networking subscriptions” on page 111 in Merid-
ian/Succession Companion Overview (553-3601-103).

Table 51 Disable handset subscription

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the Subscriptions window.

Follow the instructions on, page 27.

4 Select a handset subscription(s) for disabling.

Note: You can select a single handset, a list of handsets, or all
handsets on a DMC.

Highlight a DMC TN and an Index, or several indexs in the list.

5 Disable the handset subscription(s).

From the Operations pull-down menu, click on Disable.
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Table 51 Disable handset subscription

Step Action

6 Disable from this system only.

Click on OK button.

7 Disable from all systems where the portable set is subscribed.
Click on OK button.
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Copy a handset subscription

Figure 47:

DECT Subscriptions window and DECT Copy Subscription dialog
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NOTE

See the following for explanations, “Copy subscriptions” on page 105
in Meridian/Succession Companion Overview (553-3601-103).
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Table 52 Copy handset subscription

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Select the source MDECT system to copy the subscription.

Highlight the MDECT system in the DECT Systems window.

4 Open the Subscriptions window.

Follow the instructions on, page 27.

5 Open the DECT Copy Subscription dialog.

From the Edit pull-down menu, click on Copy.

6 Select an MDECT system where you want the subscription you are
copying.
Pull-down the Destination DECT System list and highlight a system
name.

7 Select DMC on the MDECT system where you want the subscription
you are copying.

Pull-down the Destination DMC list and highlight a DMC.

8 Select a handset subscription(s) to copy.

Note: You can select a single handset, a list of handsets, or all
handsets on a DMC.

Highlight a DMC TN and an Index, or several indexs in the list.
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Table 52 Copy handset subscription

Step Action

9 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index, or several To: indexs in the
list.

10 Accept the changes.

Click on the OK button.
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Move a handset subscription

Figure 48:

DECT Subscriptions window and DECT Move Subscription dialog
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NOTE

See the following for explanations, “Move Subscriptions” on page 107
in Meridian/Succession Companion Overview (553-3601-103).
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Table 53 Move handset subscription

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the Subscriptions window.

Follow the instructions on, page 27.

4 Open the DECT Move Subscription dialog.

From the Edit pull-down menu, click on Move.

5 Select an MDECT system where you want the subscription you are
Moving.

Pull-down the Destination DECT System list and highlight a system
name.

6 Select DMC on the MDECT system where you want the subscription
you are moving.

Pull-down the Destination DMC list and highlight a DMC.

7 Select DMC on the MDECT system where you want the subscription
you are moving.

Pull-down the Destination DMC list and highlight a DMC.

8 Select a handset subscription(s) to move.

Note: You can select a single handset, a list of handsets, or all
handsets on a DMC.

Highlight a DMC TN and an Index, or several indexs in the list.
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Table 53 Move handset subscription

Step Action

9 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index, or several To: indexs in the
list.

10 Accept the changes.

Click on the OK button.
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Find a handset subscription

Figure 49:

DECT Subscriptions window and Find DECT Subscription dialogs
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NOTE

See the following for explanations, “Find subscriptions” on page 109
in Meridian/Succession Companion Overview (553-3601-103).

Table 54 Find handset subscription

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the Subscriptions window.

Follow the instructions on, page 27.

4 Open the Find DECT Subscription dialog.

From the Edit pull-down menu, click on Find.

5 Select find criteria.

Click on Find IPUI or Find Home DN, enter the value, and click on the
Find button.

6 View the results.
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Import a handset subscription

Figure 50:
DECT Subscriptions window and DECT Import Subscription dialog
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NOTE

See the following for explanations, “Import Subscriptions” on page
107 in Meridian/Succession Companion Overview
(553-3601-103).
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Table 55 Import handset subscription

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the Subscriptions window.

Follow the instructions on, page 27.

4 Open the DECT Import Subscription dialog.

From the File pull-down menu, click on Import.

5 Select an MDECT system where you want the subscription you are
Importing.

Pull-down the Destination DMC list and highlight a DMC.

6 Select DMC you want to import.

Pull-down the Destination DMC list and highlight a DMC.

7 Select a handset subscription(s) to import.

Note: You can select a single handset, a list of handsets, or all
handsets on a DMC.

Highlight a DMC TN and an Index, or several indexs in the list.
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Table 55 Import handset subscription

Step Action

8 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index, or several To: indexs in the
list.

9 Accept the changes.

Click on the OK button.
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Export a handset subscription

Figure 51:

DECT Subscriptions window and Export Subscription dialog
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NOTE

See the following for explanations, “Export Subscriptions” on page

108 in Meridian/Succession Companion Overview

(553-3601-103).
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Table 56 Export handset subscription

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the Subscriptions window.

Follow the instructions on, page 27.

4 Open the Export DECT Subscription dialog.

From the Find pull-down menu, click on Export.

5 Select a handset subscription(s) to export.

Note: You can select a single handset, a list of handsets, or all
handsets on a DMC.

Highlight a DMC TN and an Index, or several indexs in the list.

6 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index, or several To: indexs in the
list.

7 Accept the changes.

Click on the OK button.

8 Paste the subscriptions into a file.
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Force a disable handset subscription

Figure 52:

DECT Subscriptions window and Force disable DECT Subscription dialog
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NOTE

See the following for explanations, “Force disable” on page 113 in
Meridian/Succession Companion Overview (553-3601-103).
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Table 57 Force disable handset subscription

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the Subscriptions window.

Follow the instructions on, page 27.

4 Open the Force Disable DECT Subscription dialog.

From the Operations pull-down menu, click on Force Disable.

5 Select a handset subscription(s) for Force Disabling.

Note: You can select a single handset, a list of handsets, or all
handsets on a DMC.

Highlight a DMC TN and an Index, or several indexs in the list.

6 Disable the handset subscription(s).

From the Operations pull-down menu, click on Force Disable.

7 Disable from this system only.

Click on OK button.

8 Disable from all systems where the portable set is subscribed.

Click on OK button.
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Update data on OTM or update data on an
MDECT system

Figure 53:
Mismatch dialogs
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When the DECT manager connects to an MDECT system,
synchronization flags differences between the DECT manager
database and the MDECT system database with mismatch dialogs.
These dialogs are useful when provisioning MDECT systems off-site.
See “Provision an MDECT system remotely” on page 107, and “Subscribe an
MDECT system remotely” on page 110.

Table 58 Update data on OTM

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Select an MDECT system.

Highlight an MDECT system from the list.

4 Connect to an MDECT System.

From the Applications pull-down menu, click on Connect or click on

the EEE (green) icon.

5 If any of the dialogs in Figure 54 appear, you must decide to update
either the DECT manager or the DECT system.

Click on either the Update DECT Manager button, or Update DECT
System button.
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Provision an MDECT system remotely

A distributor can use an MDECT System, on the distributors premises
lab to configure a system and subscribe sets on it. If the DECT
Access System and board configuration is the same on the
distributor and the end-customer MDECT Systems, and if the
handsets are properly programmed on the end-customer Meridian
side, then the DMCs can be placed in the end-customer system and
the handsets function properly.

Remote DMCS8 provision where the customer site
has a DECT manager

Figure 54:
Remote DMC8 provision where the customer site has a DECT manager
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Table 59 Remote provision where the customer site has a DECT manager

Step Action

1 Remotely provision DMC8s for a customer site.

Follow the steps 1 to 6a/6b shown in, Figure 54.
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Remote DMCS8 provision where the customer site
does not have a DECT manager

Figure 55:
Remote DMCS8 provision where customer site does not have a DECT manager
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Table 60 Remote DMCS8 provision where the customer site does not have a
DECT manager

Step Action

1 Remotely provision a customer site.

Follow the steps 1 to 6 shown in, Figure 55.
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Subscribe an MDECT system remotely

A handset set can be subscribed on-air on any MDECT System,

regardless of the MDECT System PARI and SARI. In other words, a
handset can be subscribed on an MDECT System where the handset
is not necessarily intended to be operational. The customer may or

may not have a DECT manager on site.

Remote handset subscription where the customer site
has a DECT manager

Figure 56:

Remote handset subscription where the customer site has a DECT manager
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Table 61 Update IP address on OTM

Step Action

1 Remotely provision a customer site.

Follow the steps 1 to 7 shown in, Figure 56.
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Remote handset subscription where the customer site

does not have a DECT manager

Figure 57:

Remote handset subscription where customer site does not have a DECT manager
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Table 62 Update IP address on OTM

Step Action

1 Remotely provision a customer site.

Follow the steps 1 to 4 shown in, Figure 57.
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Change passwords

Figure 58:
DECT Systems window and Change DECT Password

For lost passwords, see “Password recovery” on page 191.
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Table 63 Change passwords

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the
General tab.

4 Select Change Password.

Click on the Change Password button.

5 Change the password.

Enter the Old Password, enter the New Password, confirm the New
Password, and click on the OK button.
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Change the MDECT system name

Figure 59:
DECT Systems window and DECT System Properties - General tab
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Table 64 Change the MDECT system name

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the
General tab.

4 Change the MDECT system name.

Enter the new name in the DECT System Name box.
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Change IP address on OTM DECT manager

Before changing the IP address on the manager, close the
connection, and after the change and the MDECT system, open the
connection as a safety check.

Figure 60:
DECT Systems window and DECT System Properties - Communication tab
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Table 65 Change IP address on MDECT system

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the
Communication tab.

4 Select Ethernet.

Click on the Ethernet radio button.

5 Accept the changes.

Click on the OK button.
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Change IP address on MDECT system DMCS8
Relay card

Before changing the IP address on the manager, close the
connection, and after the change and the MDECT system, open the
connection as a safety check.

Figure 61:
Telnet 192.168.1.1

o Telnet - 192.168.1.104 ME E
LConnect Edit Terminal Help

login: dasuser

password:
local> ipconfig 192_.168.1.184 255 _255_255.8 192.168.1.199
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Complete the following steps:

Table 66 Change IP address on MDECT system DMC8 Relay card

Step Action

1 Open the Telnet dialog.

Click on Start>Accessories>Telnet.

2 Enter user name and password.

Type user name dasuser and password dasuser.

3 When the connection prompt local appears, change the Relay DMC8
card address.

Enter the following command:
ipconfig XXX.XXX.XXX.XXX YYY.YYY.YYY.YYY 222.222.222.222

XXX.XXX.XXX.XXX = new IP address of the Relay DMC8 card.
YYY.YYY.yyy.yyy = subnet mask, usually 255.255.255.0
zzz.zzz.zzz.zzz = |IP address if this is the gateway for your network.

Note: zzz.zzz.zzz.zzz should be setto the IP address of the OTM server
Ethernet interface. If you have two Ethernet interfaces on the OTM
server, zzz.zzz.zzz.zzz should be set to the IP address of the interface
which is on the same network as the DMC8 Relay card.
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Change a PARI or SARI

NOTE

When the PARI or SARI changes, the MDECT system resets
and the connection closes. If the connection is permanent, the
OTM manager attempts to open in the background.

Figure 62:
DECT Systems window and DECT System Properties - Access tab
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Table 67 Change a PARI or SARI

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the
Access Right Identification tab.

4 Change the PARI or SARI.

Enter the PARI or SARI.

5 Accept the changes.

Click on the OK button.
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Change the Upstream Manager IP address

NOTE

An upstream manager IP address can only be programmed on
the DMC8 Relay card.

Figure 63:
DECT Systems window and DECT System Properties - Alarm tab
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Table 68 Change the Upstream Manager IP address

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the
Alarm tab.

4 Change the upstream manager IP address.

Enter the Upstream Manager IP address.

5 Accept the changes.

Click on the OK button.

553-3601-301 Standard 4.00 June 2001



MDECT System administration Page 125 of 200

Change time and date

The time and date is used to time stamp the alarms.

NOTE

You must change the time and date when the MDECT system
reboots or a DMC resets.

Figure 64:
DECT Systems window and DECT System Properties - Alarm tab
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Table 69 Change time and date

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Connect to an MDECT System.

From the Applications pull-down menu click on Connect or EEE
(green).

4 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the
Alarm tab.

5 Change the time and date.

Enter the Date and Time.

6 Accept the changes.

Click on the OK button.
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Change parameters

Figure 65:
DECT Systems window and DECT System Properties - Parameters tab
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Table 70 Change parameters

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the DECT System Properties dialog.

From the File pull-down menu, click on Properties, and click on the
Parameters tab.

4 Change the parameters.

From the appropriate pull-down menus, highlight the parameter
time/level.

5 Accept the changes.

Click on the OK button.
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Keep or remove non-operational DMCS8s
from OTM

NOTE

Figure 66 only appears when a connection is established and
there is a mismatch. If there is a permanent connection and the
MDECT system configuration changes, the OTM DECT manager
is updated automatically and the change is noted in the OTM
event log.

Figure 66:
Synchronize DECT Board Configuration dialog

E%Dplivily Telephony Manager - Synchronize DECT Board Configuration E3

The following boards are not operational anymore.

DMC TR Keep in the OTW Configuration
01001 [ -
01002 v
01101 [
n14n? r ;I

Please select the hoards that must be keptin the OTM DECT configuration.

oo |

Table 71 Keep or remove non-operational DMC8s from OTM

Step Action

1 To keep DMCs,

Delete the check mark from the appropriate box.
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Table 71 Keep or remove non-operational DMC8s from OTM

Step Action

2 To remove DMCs,

3 Put a check mark in the appropriate box.

4 Accept the changes.

Click on the OK button.
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Keep or remove non-operational base stations
from OTM

NOTE

Figure 67 only appears when a connection is established and
there is a mismatch. If there is a permanent connection and the
MDECT system configuration changes, the OTM DECT manager
is updated automatically and the change is noted in the OTM
event log.

Figure 67:
Synchronize DECT Radio Fixed Part Configuration dialog

E‘-"g’gﬂptivity Telephony Manager - Synchronize DECT Radio Fixed Part Configuration [E3

The following Radio Fixed Pars are not operational anymaore.

D T Radio Identifier kKeepinthe OThM Configurat...
01003 0 [ -
01003 1 [
01003 2 [v
01103 0 [v
01103 1 [v
01103 2 [
o : L |

FPlease selectthe Radio Fixed Pars that must be kept in the OTM DECT configuration.

(0] I Help |
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Table 72 Keep or remove non-operational base stations
from OTM

Step Action

1 To keep base stations,

Delete the check mark from the appropriate box.

2 To remove base stations,

Put a check mark in the appropriate box.

3 Accept the changes.
Click on the OK button.
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Resolve a subscription configuration
mismatch

NOTE

Figure 68 can appear when subscriptions are done with the Sub-
scriptions window Operation pull-down menu, clicking on Con-
figure, and not also configuring the handset on the
Meridian/Succession with Station Administration.

Figure 68:
DECT Subscriptions Configuration Mismatch dialog, and DMC window

Eg’%l]ptivity Telephony Manager - DECT Subscription Configuration Mis... [E3
The subscription configuration has changed on the DECT Systern.
The hoards where the configuration has changed are listed below.

010mm 1=
01002
01003
01004 —
01005
01 006
01007

-

FPlease synchronize the board subscription configuration frorm the Board YWindow:. Synchronize From

| L% synchronize To
Help

E_ZE]I]ptivity Telephony Manager - Sample Site - Sample System - test - DMC

File Wiew Synchrofization ‘indows Help

any
++

[¥ Show Operational |+ Show Mon Operational

D TH Type Relay State Mumber of Lisers

oo v DMC4 Mo Dperational 0| ALt
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Table 73 Select login options

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 21.

2 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system, launch the DECT application, open the DECT Sys-
tems window.

Follow the instructions on, page 22 to page 25.

3 Open the DMC window.

Follow the instructions on, page 27.

4 Store DMC changes from the MDECT system in the OTM server,

In the Synchronization pull-down menu, click on Synchronize From.

5 Make OTM server changes to the DMCs in the MDECT system,

In the Synchronization pull-down menu, click on Synchronize To.
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User Access security
Web based navigator Access security

You can allow or deny Group access to MDECT OA&M features or
handset subscriptions with the Web Access security screen.

Figure 69:
OTM Web Access security
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Table 74 Web based navigator Access security

Step Action

1 Using a Web based navigator, open the Administrator login screen,
login, select the System Navigator, select the Meridian 1 that supports
the MDECT system.

Follow the instructions on, page 22 to page 25.

2 Select Web Navigator Access.

Click on Web Navigator Access.

3 Follow the on-screen instructions.

A check in the Allow Access column boxes allows access for the selected
users group. No check in the boxes denies access to the selected users

group.
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Windows Access security

You can allow or deny Group access to MDECT OA&M features with
the Windows Administration Template Properties dialog.

Figure 70:
OTM Navigator, OTM Users, and Template Properties
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Table 75 Windows Access security

Step Action

1 Using Windows, Login to OTM to open the OTM Navigator window.

See “Login to the OTM” on page 19.

2 Open the OTM Users window.

From the Security pull-down menu, click on OTM Users.

3 Open the Template Properties.

From the Configuration pull-down menu, click on User Templates.

4 Select the appropriate access level for the user group.

Click the left mouse button on the icon to change the access, as fol-
lows:

B

iE] = Read only access*

Read and write access

iz = No access

Note: * Choosing read only access allows read and write access.
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MDECT System maintenance

The following index is a navigator for this chapter:

A
Alarm
code 143
notification 153
Web browser 151
B
Base station
cancel mute alarms 172
disconnect 173
LED status 159
mute alarms 170
re-install 173
remove and re-install 170
D
DMC8
add to an MDECT system 167
backup configuration 161
insert 160
insert servicable 164
LED status 157
remove 160
remove faulty 162
restore subscription data 166
reuse 169
E
Event
log 155
monitor 155
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F
Firmware
upload and activation 175
Firmware upload
failure recovery 177
M
maintenance bypass cable 163
P
parameters 190
Password recovery 191
Performance Collection
equipment 183
user 183
R
RSSI
current data 180

553-3601-301 Standard 4.00 June 2001



MDECT System maintenance Page 143 of 200

Alarm Code maintenance actions

You can view Alarm Codes with one of the following:
e “Windows Alarm Snapshot” on page 143
e “Web Alarm browser” on page 151

* “Windows Alarm Notification” on page 153
Windows Alarm Snapshot

Figure 71:
Alarm Snapshot window and Alarm Properties dialog

|@ OTH - Alarm Snapshot - Sample Site - Sample System - test

File View Help

34
® | @
Severity | Alarm Code | DMC TH | Radio Identifier Date & Time Operator Data
Critical |DCT102 48 2 06 12/01/2001 18:18:31 RFF alarmis) on DMC
Critical |DCT102 48 2 07 12/01/2001 18:18:47 RFF alarmis) on DMC
Critical |DCT103 48 2 D? 12/01/2001 18:18:47 RFF Alarm Muted when no...

Critical c : | 12501)2001 18 37 Remate bit error rate bhad

Critical | OTHM - Alarm Properties '1? a7 Lacal bit errar rate bad

Severity: IW
Alarm Code: W
OMC TH: N
Radio Identifier: n—
Alarm Code: W

perator Data

Remote bit error rate bad

_ox | _res |

Cannected

Meridian/Succession Companion DECT Operation Administration and Maintenance



Page 144 of 200 MDECT System maintenance

NOTE

The Alarm Snapshot window is a static display. The Alarm
Snapshot window only shows the alarms present at the time the
window was opened. The window must be refreshed for an
up-to-date display.

The Web based alarm browser displays alarm history and occurring
alarms.

Table 76 Alarm Code maintenance actions

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window, and open the Current Alarms window.

Follow the instructions on, page 19 to page 27.

2 Refresh the Alarm Snapshot window.

Click on the | icon.

3 Examine the alarm code, and take the appropriate maintenance action.

See Table 78 on page 152.

NOTE

The Windows Alarm Notification browser, on page 153 only dis-
plays alarms that have occurred since the window was opened.
The Web Alarm browser, page 151 has a circular log that pro-
vides information on a limited history of alarms. The Web Alarm
browser records alarms at all times.
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Table 77 Alarms

Alarm
code

Alarm description Maintenance action

DMC8 Operational State Synthesis

DCTOO01 | All DMC8s are operational. Information only, no action needed.
(DCTO001 only displayed in
the Alarm browsers. DCT001
does not show in the Alarm
Snapshot list.)

DCT002 | At least one DMCS8 is not Remove the DMC8 and insert the
operational. _ DMC8 again to reboot If the reboot
(DCTO02 only displayed in fails, replace the DMCS8.

the Alarm browsers. DCT002
does not show in the Alarm
Snapshot list.)

Note: When at least one DMC8 becomes inoperable, DCT002 appears in the
alarm browser history. When all the DMC8s become operational again, DCT001
appears in the browser history.

Presence of an alarm

DCT101 | No alarms. Information only, no action needed.
(DCT101 only displayed in
the Alarm browsers).

DCT102 |1 DCT102 displayed in the 1 Openthe Alarm Snapshot window

Alarm browsers is an for alarm details and perform the
alarm on a DMCS8. corresponding maintenance

2 DCT102 displayed in the ESUOIS,
Alarm Snapshot as an 2 Look for one or more DCT202 to
alarm on a base station. DCT215 alarms in the Alarm

Snapshot window, and perform
the corresponding maintenance
actions.

DCT103 | Base station alarm muted Configure the base station using the
when no alarms. Look for one | OTM or disconnect the base station.
or more DCT501 alarms for
details.(DCT103 only dis-
played in the Alarm Snapshot
window.)
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Alarm
code

Alarm description

Maintenance action

DCT104 | Faceplate cable alarm(s) on Perform the DCT302 to DCT307
DMCS8. Look for one or more maintenance action.
DCT302 to DCT307 alarms
for details.(DCT104 only dis-
played in the Alarm Snapshot
window.)
DCT105 | Software alarm(s) on DMCS8. Perform the DCT402 to DCT407
Look for one or more DCT401 | maintenance action.
to DCT403 alarms for details.
(DCT105 only displayed in
the Alarm Snapshot window.)
Base station alarms
DCT201 | No base station alarm. Information only, no action needed.
(DCT201 only displayed in
the Alarm browsers.)
DCT202 Local receiver signal miss- Disconnect the base station for 30
ing (base station discon- seconds.
nected). 1 Replace the base station.
If a disconnection does not 2 Replace the base station's
solve the problem, one of the DMCS.
following could be the cause: )
. 3 Check the faceplate cabling.
1 the base station
2 the base station’s DMC8
3 a cable problem between
the base station and the
DMCS.
DCT203 Local loss of receiver slot Perform the DCT202 maintenance
synchronization. action.
DCT204 Local loss of receiver frame Perform the DCT202 maintenance
synchronization. action.
DCT205 Local bit error rate bad. Perform the DCT202 maintenance
action.
DCT206 | Remote receiver signal miss- | Perform the DCT202 maintenance
ing. action.
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Alarm
code

Alarm description

Maintenance action

DCT207 | Remote loss of receiver slot Perform the DCT202 maintenance
synchronization. action.
DCT208 | Remote loss of receiver Perform the DCT202 maintenance
frame synchronization. action.
DCT209 | Remote bit error rate bad. Perform the DCT202 maintenance
action.
DCT210 | Synthesizer out of synchroni- | Perform the DCT202 maintenance
zation. action.
DCT211 | Power amp out of order. Perform the DCT202 maintenance
action.
DCT212 | Round-trip delay changed. Perform the DCT202 maintenance
action.
DCT213 | RFP synthesizer type Perform the DCT202 maintenance
changed. action.
DCT214 | LFC out of synchronization Disconnect and reinsert the DMCS8.
with BMC.
DCT215 | Error due to synchroniza- Can affect your interpretation of the
tion-port mutation. alarm snapshot or alarm browser
applications; however, the alarm
should clear automatically within
200 seconds.
Faceplate cable alarms
DCT301 | No faceplate cable alarm. Information only, no action needed.
(DCT301 only displayed in
the Alarm browsers.)
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Alarm
code

Alarm description Maintenance action

DCT302 | The DMC8 is working; however, | Remove all the DMC8s. Check the

there is a loss of faceplate strap setting on the DMC8s. Check
cable synchronization. the faceplate cabling. Reinsert all
the DMC8s.

If the above procedure does not
solve the problem, try to find which
DMCS8 gives the error condition by
inserting the DMC8s one at a time
with a minute in between insertions.

If needed, replace the defective
DMC8 or the defect faceplate cables.

DCT303 | No faceplate cable synchro- Perform the DCT302 maintenance
nization found. action.

The DMCS8 responsible for
this alarm cannot pass the
alarm on to the DMC8 Relay
card.

DCT304 | The DMC8 is working; however, | Do not connect faceplate cables to
someone connected a faceplate | @ DMC8 on an active MDECT sys-
cable section to the DMC8, tem.

causing a counter difference.

DCT305 | The DMC8 is working; however, | Perform the DCT302 maintenance
there is a timing signal loss action.
within the DMCS8.

DCT306 | The DMC8 is working; however, | Perform the DCT302 maintenance
the input of the faceplate cable | action.
controller is locked.

DCT307 | The DMC8 is working; however, | Perform the DCT302 maintenance
the processor is overloaded action. If the DCT302 action does

with too many faceplate cable | Not solve the problem, try provision-
messages, causing an 1/0 ing an additional DMCS8.
transmit overflow.

Software alarms
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Alarm
code

Alarm description

Maintenance action

DCT401 | The DMC8 is working; however, | In the Boards window, Synchronize
there is a subscription data- From the DMCS8, then Synchronize
base corruption. To the DMCS8.

DCT402 | The DMC8 is located in a Perform the DCT401 maintenance
card slot position that does action.
not match the DMC8 sub-
scription data card slot
address. The mismatch is
due to one of the following:

e the DMCS8 is placed in the
wrong card slot position

e the DMC8 will not come
into service

DCT403 | Duplicate subscription in the Perform the DCT401 maintenance
system. action. If the problem does not
A subscription is moved from clear, look for duplicated subscrip-
a source DMCS to a destina- | fion IEUI in the Subscription Prop-
tion DMC8: however. the erty dialog. Delete the unnecessary
original subscription is still subscription from the source DMCS8.
present on the source DMCS8.

The DCT403 alarm should
always come from both the
source and destination
DMCS8s.
DCT404 | (DCT404 only displayed in If this alarm was caused by a soft-

the Alarm browsers.) One of
the following events
occurred:

e the power was turned on

« the DMC8 was inserted into
the shelf backplane

« a software exception
restarted the DMC8

ware exception. Examine the alarm
browsers for details.
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Alarm description Maintenance action

Radio Fixed Part alarm muted

DCT501 | Alarms are muted in the RFP Use the RFP window to Cancel
window, however the base Mute Alarms.

station does not have any
intrinsic alarms.

Backplane controller unit

DCT601 | This alarm is used by Nortel Information only, no action needed.
Networks designers.
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Web Alarm browser

The Web Alarm browser has a circular log that provides
information on a limited history of alarms. The Web Alarm
browser records alarms at all times.

Figure 72:
OTM web system alarms
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Table 78 Alarm Code maintenance actions

Step Action

1 Using a Web based navigator, open the login screen, login, select the
System Navigator, select the Meridian 1 that supports the MDECT sys-
tem, select Alarms.

Follow the instructions on, page 22 to page 25.

2 Examine the code, and take the appropriate maintenance action.

See Table 77 on page 145.
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Windows Alarm Notification

Alarm Notification provides an alert by pagers, E-mail, and forwards
SNMP traps to an upstream processor. For more information about the

Alarm Notification, see Using Optivity Telephony Manager for Meridian 1
(553-3001-330).

Figure 73:
Alarm Notification
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Table 79 Alarm Notification

Step Action

1 Using Windows, open the login screen, login, select the Alarm Notifica-
tion from the Utilities menu of the OTM Windows Navigator.

Follow the instructions on, page 22 to page 25.

2 Examine the Message ID, and take the appropriate maintenance
action.

See Table 77 on page 145.
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Event Monitor window

The Event Monitor window displays the Meridian 1 system's Event
Log, allowing you to view all recent system events stored in the
Meridian 1 history file. For more information about the Alarm
management, see Using Optivity Telephony Manager for Meridian 1
(553-3001-330).

Figure 74:
Event Log
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Table 80 Event Log

Step Action

1 Using Windows, Login to OTM, select the Event Log Viewer from the
Maintenance menu of OTM Windows Navigator.

Follow the instructions on, page 22 to page 25.

2 Examine the Application column.

DECT indicates an MDECT event.

3 Examine the Data Group column.

Gives the Site name, PBX name, MDECT name.
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Table 80 Event Log

Step Action

4 Examine the Message ID column.

Non-error logs range from 1 to 9999.
Error logs range from 10000 to 19999.

5 Examine the Message column.

Messages are explanation of Message ID number codes.
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LED status for DMC8/DMCS8-E and base station

LED status

Companion system LED status indicates the functioning of the
DMC8/DMC8-E and base station power and card subsystem operation.

Table 81 DMC8/DMCB8-E red LED status

Red LED

State Description Action
On The card is one of the following: 1 Program the card. See
1 not programmed page 133.
2 disabled 2 Re-enable the card.
Use LD 32 ENLC I s c.
3 has faults
3 Replace the card. See
page 160.
Flashes Card is doing a self test. Wait.
three times
Off 1 The card is in service if the 1 No action.
yelloyv LED is off and the green 2 Restore power.
LED is on.
2 The card has no power if all LEDs
are off.
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Table 82 DMC8/DMCS8-E yellow/green LED status

Yellow Green

LED LED Description Action
Status Status

Off Off Power down. Restore power.
On Off Hardware testing by boot Wait.

program.
On On Wait for download command | Wait.

by the boot program.

On Loop# No valid main program Start firmware distribution
found by the boot program. with the DECT Manager.
Card is continuously restart-

ing.
Slow On Faults caused by one of the | Wait.
flasht following: Do not remove the card,
« software download in removal corrupts the
progress flashROM data.

« software distribution in
progress

e subscription or
configuration data is
saving to the flash ROM

Off Fast Card is synchronizing to the | Wait.
flashtt | faceplate cable bus.

Legend for LED action:
T Slow flash = 2 seconds On and 2 seconds Off

ttFast flash = 1 second On and 1 second Off
T Loop for no program = 3 seconds On and 0.25 seconds Off
¥ Loop for corrupted program = 12 seconds On and 0.25 seconds Off
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Table 82 DMC8/DMCB8-E yellow/green LED status

Yellow Green

LED LED Description Action
Status Status

Off Slow 1 Card hasno PARI,orhas | 1 Contact your technical
flasht an incomplete PARI. support group.
2 Card has detected 2 Replace the card. See
an error. page 160.
Off On Card is in service. No action required.
Slow Slow Simultaneous occurrence Contact your technical sup-
flasht flasht of: port group.

e« card has no PARI, or
incomplete PARI and

e either software
distributionis in progress
or subscription or
configuration data is
saving to the flashROM

Legend for LED action:
T Slow flash = 2 seconds On and 2 seconds Off

ttFast flash = 1 second On and 1 second Off
T Loop for no program = 3 seconds On and 0.25 seconds Off
T Loop for corrupted program = 12 seconds On and 0.25 seconds Off

Table 83 Base station LED status

Green Description Action
Off No power. Check DMCS8 to base sta-
tion cables.
Flashes Input power present but no Check DMC8 LED Status
output power. and Alarm Reports.

Check DMCS8 to base sta-
tion cables.

On Power present and communications No action required.
with DMC8 established.
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Remove and insert a DMCS8 for maintenance

CAUTION: Service interruption

Do not bypass the DMC8-E or the DMC8 immediately to the left
of the DMCB8-E. A bypassed DMCB8-E can not regenerate the
faceplate bus signals in the left half of the shelf.

Although the separated left half of the shelf remains in syn-
chronization, system performance decreases as follows:

« any calls passing through the separated part of the faceplate
bus drop.

* handsets configured on a DMC in the separated half cannot
make or receive calls through a base station in the other half.

To remove, re-seat, or insert DMC8s, continue as follows:
e backup the data from the DMC8 you need to remove
e remove the faulty DMC8

e insert a working DMC8

e restore the data to the DMC8 you replaced
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Backup a DMCB8 configuration and subscription
information

Figure 75:
DMC window
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Table 84 Backup a DMC configuration and subscription information

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window, and open the Boards window.

Follow the instructions on, page 19 to page 27.

2 Select the DMCS8.
Highlight the DMC8 in the list.
3 Save the DMC8 data on the OTM.

From the Synchronization pull-down menu, click on Synchronize
From.
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Remove a faulty DMCS8

Figure 76: DMC8 removal
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Table 85 Remove a faulty DMC8

Step Action

1 Connect the maintenance bypass cable.

Plug the maintenance bypass cable into the Maint port of the DMC8s
on either side of the DMC8 to be removed.

2 Disconnect the faceplate cables.

Detach the faceplate cables on the DMC8 to be removed and on the
cards on either side of it.

3 Remove the DMCS8.

Release the card locking devices and lever the card out of the
shelf backplane.

Meridian/Succession Companion DECT Operation Administration and Maintenance



Page 164 of 200 MDECT System maintenance

Insert a serviceable DMCS8

Figure 77: DMC8 insertion
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Table 86 Insert a serviceable DMC8

Step Action

1 Insert the DMCS.

Lever the card into the shelf backplane and latch the card
locking devices.

2 Connect the faceplate cables.

Insert the faceplate cables into the DMC8 just inserted and into the
cards on either side of it.

3 Disconnect the maintenance bypass cable.

Remove the maintenance bypass cable from the Maint port of the
DMC8s on either side of the replaced DMCS8.
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Restore subscription data to the serviceable DMC8

Figure 78:
DMC window
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Table 87 Restore subscription data to the serviceable DMC38

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window, and open the Boards window.

Follow the instructions on, page 19 to page 27.

2 Select the DMCS8.

Highlight the DMC8 in the list.

Save the DMC8 data on the OTM.

From the Synchronization pull-down menu, click on Synchronize To.
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[ )
NOTE
NoTE ,
Restore only one DMC (Board) at a time.

Add a DMC8 to an MDECT system

Figure 79: Adding a DMC8 to the system
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Table 88 Add a DMC to a DECT system

Step Action

1 Connect the bypass cable.

Plug the bypass cable into the Maint port of the existing DMCS8.

2 Insert the DMC8, with a terminating plug installed into the top %
port.

Lever the card into the shelf backplane and latch the card locking
devices.

3 Connect the bypass cable to the added DMCS8.

Plug the bypass cable into the Maint port of the added DMC8.

4 Remove the terminating plug from the existing card.

Remove the terminating plug from the bottom ~®¥ port of the exist-
ing DMCS8.

5 Connect the faceplate cable.

Insert the faceplate cables into the bottom ~®® port of the existing
DMC8 and the added DMCS8.

6 Disconnect the bypass cable.

Remove the maintenance bypass cable from the Maint port of the
existing DMC8 and the added DMCS8.

7 Add the DMCS8 to the database.

Use the procedure on page 166.
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Reuse a DMCS8 in another MDECT system

Figure 80:
DMC window
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Table 89 Reuse a DMC8 in another MDECT system

Step Action

1 Select the DMC8 to be reused.

Highlight the DMC8 in the list.

2 Delete the subscriptions from the DMC8 memory.

From the File pull-down menu, click on Clear.
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Remove and re-install a base station for
maintenance
Mute alarms on a base station

Figure 81:
RFP window, and DECT Radio Fixed Parts properties dialog
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Table 90 Mute alarm on a base station

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window, and open the RFP window.

Follow the instructions on, page 19 to page 27.

2 Select the DMC8 to mute.

Highlight the DMC8 in the list.

3 Mute the alarms.

From the File pull-down menu, click on Mute Alarms, or click on the

E icon.
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Cancel mute alarms on a base station

Table 91 Cancel mute alarms on a base station

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window, and open the RFP window.

Follow the instructions on, page 19 to page 27.

2 Select the DMC8 to cancel mute alarms.

Highlight the DMC8 in the list.

3 Cancel mute alarms.

From the File pull-down menu, click on Cancel Mute Alarms, or click

on the & icon.
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Disconnect and /Re-install a base station

Figure 82: Disconnect/re-install the base station

553-8143a

NOTE

After disconnecting the cable to the base station, wait for 60
seconds before reconnecting another base station.
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Table 92 Disconnect/Reinstall a base station

Step Action

1 Disconnect the RJ45 cable, MDF side.

Unplug the RJ45 cable from the wall socket of the RJ45 box.

2 Disconnect the RJ45 cable, base station side.

3 Remove the unserviceable base station from the mounting plate.
4 Re-install a serviceable base station on the mounting plate.

5 Re-connect the RJ45 cable to the base station.

6 Re-connect the RJ45 cable, MDF side.
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Firmware upload and activation

Figure 83:
DECT Systems, DECT Firmware Upload, DECT Firmware Activation, Upload
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Table 93 Firmware upload and activation

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window.

Follow the instructions on, page 19 to page 27.

2 Open the Firmware upload dialog.

Select the Firmware pull-down menu, and click on Upload.
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Recover from a Firmware upload failure
It is possible to upload DMC firmware with the V.24 port of a DMC8
using a PC equipped with Z-modem protocol. During the upload the
DMC8 deletes the active and standby firmware and stores the
uploaded firmware as the active firmware. When the upload
completes, the boot program starts the uploaded firmware.

Figure 84: Recovery upload to a DMCS8
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Table 94 Firmware upload and activation

Step Action

1 Configure the COM port settings.
baud rate = 19200

data bits = 8

parity = no parity

stop bit = no flow control

2 Connect the NTCW12AA cable to the DMC8 to be uploaded.

Refer to Table 95 on page 179 for the NTCW12AA cable tip and ring con-
nections.

3 Locate the OTM server COM port.

Connect the NTCW12AA cable connector into the PC COM port.
4 Unseat the DMCS8.

Disconnect the DMC8 from the shelf backplane.

5 Access Z-modem application.(example, Windows HyperTerminal)

Start > Programs > Accessories > HyperTerminal.

6 Initiate the file transfer.

Start the Z-modem application on the PC.

7 Activate the boot program.

Insert the DMCS8 into the shelf backplane.
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NOTE

The BIX tip and ring connections shown in Table 95 on page 179
correspond to standard BIX designation. The first pair are
labeled TO and RO. (See the Installation and Maintenance NTP,
section Planning and Designating the MDF.)

Table 95 NTCW12AA cable to MDF connections

DMC8 Relay card DB25 connector Signal
. Cable color . .

MDF connection pin number designator
T1 Grey 8 V.24DCD
R2 Yellow 4 V.24RTS
T3 Blue 2 V.24TXD
R3 Red 3 V.24RXD
T4 Pink 7 V.24GND
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Current RSSI Data

The Radio Signal Strength Indication (RSSI) shows interference and
usage by a certain base station. A snapshot of the RSSI data is
retrieved and stored in a file when the user requests it. If the file
already existed, the new snapshot data is appended to the last
snapshot data in the file.

Figure 85:
Retrieve Current RSSI dialog, and Retrieve Current RSSI maps dialog
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Table 96 Current RSSI Data

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window, and open the Current RSSI| Data window.

Follow the instructions on, page 19 to page 27.

2 Select a DMC8 or DMCS8s for RSSI information retrieval.

Scroll and highlight a TN in the Select DMC(s) for RSSI Retrieval:
box.

3 Retrieve the RSSI data.

Click on the Retrieve RSSI now button.

4 Store the RSSI data.

Select a file location.
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RSSI file format

The data for each RFP is a nibble for indication of the RSSI value for
each slot (24) for each carrier (10). This results in 10 (number of
carriers) times 24 (number of slots) nibbles equal to 240 nibbles
(120 octets).

Table 97 RSSI file format

Wed Apr 18 16:00:42 CEST 2001

DMC TN : 48107

RFP1:
OFOFOFFFOFFFOFOFOFFFOFFFOFOFOFFFOFFFOFOFOFFFOFFFOFOFOFFFOFFF5FOFOFFFOFFFOFOFOFFFOFFFOFOFOF FFOF FFOF 3F5FFF5FF
FOFOFOFFFOFFFOF1FOFFFOFFFOFOFOFFFOFFFOFOFOFOFOF1FOFOFOFOFOFOFOFOFOFFFOFFFOFOFOFFFOFFFOFOFOFFFOFFFOFOFOFFFOF
FFOFOFOFFFOFFFOFOFOFFFOFFF

RFP2:
FOFFFOFOFOFFFOFFFAFOFOFFFOFFFOFOFOFFFOFFF8FOFOFFFOFFFOFOFOFOF OFFF3FOFOFOFOFFFOFOFOFFFOF FFOFOFOFFFOFOFOFOFOF
FFOFOFOFOFOFFFOFFFOFOFOFFFOFFFOFOFOFFFOFFF3F5F5FFFOFFFOFOFOFFFOFFFOFOFOF FFOFFFOFOFOFFFOF FFOFOFOF FFOFFFOFOFO
FFFOFFFOFOFOFFFOFFFOFOFOFF

553-3601-301 Standard 4.00 June 2001



MDECT System maintenance Page 183 of 200

Start/stop User Performance Collection,
Equipment Performance Collection

Figure 86: Performance Collection window and Select location dialog
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CAUTION: Service interruption

You must check to ensure the Performance Collection is not
filling all OTM server storage space.

Table 98 Start/stop User Performance Collection, Equipment Performance
Collection

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window, and open the Performance Collection window.

Follow the instructions on, page 19 to page 27.

2 Select a collection name.

Enter a name or browse for a collection name.

3 Select the check box, User Performance Collection or Equipment Per-
formance Collection, or both.

Click on the check box.

4 Select a collection period.

Note: The User Performance Collection period and the Equipment
Performance Collection period are independent of each other.

Highlight a time from the Collection Period box.

5 Select a DMCS8.
Highlight a TN from the DMC TN box.

6 Start the collection.

Click the Start button.

7 Stop the collection.

Click the Stop button.
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Equipment Performance Collection

Equipment Performance Collection file format

File name: (for example) epm-brdPP_YYYYMMDDHHMMSS.xmlI,
epm-brd24_20010418170920.xml.

DTD Document Type Definition: <<Epm.zip>>
Counter description (in the DTD order)

See “Equipment Performance Collection file sample” on page 197

Board (DMCSB8) statistical performance data

Table 99
Board statistical performance data

Counter Description

1 Indicators, not used.

2 Number of dropped calls.

3 Number of page failures.

4 Number of page retries.

5 Number of page requests.

6 Number of page rejects.

7 Number of voice calls.

8 Number of message calls

9 Number of dropped voice calls.

10 Number of dropped message calls.

11 Number of dropped voice calls in active phase.

12 Number of dropped message calls in active phase.
13 Number of dropped voice calls in passive phase.

14 Number of dropped message calls in passive phase.
15 Number of successful supplementary service calls.
16 Number of supplementary service calls with no response.
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Counter Description

17 Number of supplementary service call rejects.
18 Number of slip events on BBC highway A.

19 Number of slip events on BBC highway B.

20 Number of DECT clock errors.

RFP (base station) statistical performance data

Table 100
RFP statistical performance data

Counter Description

1 Indicators: 1 = 6 Channel RFP, 2 = 12 Channel RFP, 3 = Unknown
2 Number of times BMC overrun occurred
3 Number of times TBC established
4 Number of NT Handshake failures
5 Current radio head error code.  See Radio Head Errors table below.
6 Number of units of 100 ms since last radio head error
7 Bit counter pre-set (the measured RFP cable delay in DECT bits)
8 Number of times dummy bearer 0 was set-up
9 Number of times dummy bearer 1 was set-up
10 Number of times dummy bearer 0 was replaced
11 Number of times dummy bearer 1 was replaced
12 Number of frames with corrupted A fields (R-CRC check failed)
13 Number of frames with corrupted B-fields (X-CRC check failed)
14 Number of bad syncs
15 Number of muted frames
16 Total duration of calls using this RFP in units of 10 ms

Radio Head Errors
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Counter Description

17 Number of times Local Receiver Signal Missing.

18 Number of times Local Loss Receiver Slot Sync.
19 Number of times Local Loss Receiver Frame Sync.
20 Number of times Local Bit Error Rate Bad.

21 Number of times Remote Receiver Signal Missing.
22 Number of times Remote Loss Receiver Slot Sync.
23 Number of times Remote Loss Receiver Frame Sync.
24 Number of times Remote Bit Error Rate Bad.

25 Number of times Synthesizer Out Of Sync.

26 Number of times Power Amp Out Of Order.

27 Number of times Round Trip Delay Changed.

28 Number of times RFP Synthesizer Type Changed.
29 Number of times LFC Out Of Sync With BMC.

30 Number of times Error Due To Sync Port Mutation.

RFP (base station) Error Codes

Error codes are shown in decimal and in (hexadecimal).

Table 101
RFP Error codes

Error code Description

1 (0x01) Local Receiver Signal Missing.

2 (0x02) Local Loss of Receiver Slot Sync.

3 (0x03) Local Loss of Receiver Frame Sync.
4 (0x04) Local Bit Error Rate Bad.

5 (0x05) Remote Receiver Signal Missing.
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Error code Description

6 (0x06) Remote Loss of Receiver Slot Sync.

7 (0x07) Remote Loss of Receiver Frame Sync.
8 (0x08) Remote Bit Error Rate Bad.

9 (0x09) Synthesizer Out Of Sync.

10 (0x0A) Power Amp Out Of Order.

11 (0x0B) Round Trip Delay Changed.

12 (0x0C) RFP Synthesizer Type Changed.

13 (0x0D) LFC Out Of Sync With BMC.

14 (OxO0E) Error Due To Sync Port Mutation.

255 (OxOFF) No Error.

RFP-Channel occupation performance data

The thirteen RFP-channel occupation counters give the number of
seconds that n RFP channels were free (n = 0 - 12).
Backbone-Channel occupation statistical performance
data

The thirty three Backbone-channel occupation counters give the
number of seconds that n backbone channels were free (n = 0 - 32).
Speech-Channel occupation statistical performance data

The thirty three Speech-channel occupation counters give the
number of seconds that n speech channels were free (n = 0 - 32).
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User Performance Collection

User Performance Collection file format

File name: upm-brdPP_YYYYMMDDHHMMSS.xml,
upm-brd24_20010418170924.xml for instance

DTD Document Type Definition: <<Upm.zip>>

See “User Performance Collection file sample” on page 199

Statistical Performance Data

Table 102
Statistical Performance Data

Counter Description

1 Indicators, not used.

2 Number of page failures.

3 Number of page retries.

4 Number of page requests.

5 Number of page rejects.

6 Number of voice calls.

7 Number of message calls.

8 Number of voice calls, dropped in passive state.

9 Number of voice calls, dropped in active state.

10 Number of message calls, dropped in passive state.
11 Number of message calls, dropped in active state.
12 Number of handovers.

13 Number of failed handovers.

14 Number of aborted handovers.

15 Number of delayed handovers.

16 Current Circuit Number (OxFF, if none).
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Set parameters

Figure 87: DECT System Properties - Parameters tab
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Table 103 Set parameters

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window, open the Properties dialog, and click on the Parameters tab.

Follow the instructions on, page 19 to page 27.

2 Select the parameter.

Select a pull-down menu item, and click on Apply.

Password recovery

The MDECT System password can be changed by a customer and the
distributor managing the system would not know the changed
password. The password could be damaged in the OTM database by
a disk crash, and not backed up, or the password can be forgotten.
You cannot access passwords from the OTM.

The OTM provides a mechanism allowing you to reset the password
to the factory password. You can change the password in the MDECT
system and the OTM DECT database, or in the OTM DECT database
only.
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Figure 88:
DECT Systems window, DECT Systems Properties, Change DECT Password
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Table 104 Password recovery

Step Action

1 Using Windows, Login to OTM, select the Meridian 1 that supports the
MDECT system, launch the DECT application, open the DECT Systems
window, open the Properties dialog, and click on the General tab.

Follow the instructions on, page 19 to page 21.

2 Select password change.

Click on Change Password.

3 Change to the factory default password.
Note: The default is case sensitive.

Type Arsenal in the New password box.

4 Confirm the password.

Type Arsenal in the Confirm new password box.

5 Set up for a password change the on the MDECT system.

Remove the DMC8 Relay card, and reinsert the DMC8 Relay card.

6 Connect to the MDECT system within five minutes.

From the Applications pull-down menu click on Connect or the EEE

O

(green) icon.

Meridian/Succession Companion DECT Operation Administration and Maintenance



Page 194 of 200 MDECT System maintenance

553-3601-301 Standard 4.00 June 2001



Page 197 of 200

Appendix 1: Performance Collection
file samples

Equipment Performance Collection file sample

<?xml version="1.0"?>

<file>

<header>

<systeminfo PARI="44446666"/>

<boardinfo boardnumber="24"/>

<package package id="45100105"/>

</header>

<data>

<boardstat>
<dateandtime>2001,1,12,18,17,37,0</dateandtime>
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0</counters>
</boardstat>

<rfpinfo>

<rfpstat rfp="1">
<dateandtime>2001,1,24,19,50,9,0</dateandtime>
<counters>1,0,0,0,8,420,0,1,1,0,0,0,0,0,0,0,0,0,0,0,0,0,0,1,0,0,0,0,0,
O</counters>

</rfpstat>

<rfpstat rfp="2">
<dateandtime>2001,1,24,19,50,13,0</dateandtime>
<counters>1,0,0,0,8,420,0,1,1,0,0,0,0,0,0,0,0,0,0,0,0,0,0,1,0,0,0,0,0,
O</counters>

</rfpstat>

<rfpstat rfp="3">
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<dateandtime>2001,1,24,19,50,13,0</dateandtime>
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0</
counters>

</rfpstat>

<rfpstat rfp="4">

<dateandtime>2001,1,24,19,50,19,0</dateandtime>
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0</
counters>

</rfpstat>

</rfpinfo>

<rfpchanocc>

<rfpchocc rfp="1">
<dateandtime>2001,1,12,18,17,37,0</dateandtime>
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc>

</rfpchocc>

<rfpchocc rfp="2">
<dateandtime>2001,1,12,18,17,37,0</dateandtime>
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc>

</rfpchocc>

<rfpchocc rfp="3">
<dateandtime>2001,1,24,19,50,6,0</dateandtime>
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc>

</rfpchocc>

<rfpchocc rfp="4">
<dateandtime>2001,1,24,19,50,6,0</dateandtime>
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc>

</rfpchocc>

</rfpchanocc>

<bschanocc>

<bchanocc>

<dateandtime>2001,1,24,19,50,6,0</dateandtime>
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,4
34</choc>

</bchanocc>

<schanocc>

<dateandtime>2001,1,24,19,50,6,0</dateandtime>
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,4
34</choc>

</schanocc>
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</bschanocc>
</data>
</file>

User Performance Collection file sample

<?xml version="1.0"?>

<file>

<header>

<systeminfo PARI="44446666"/>

<boardinfo boardnumber="24"/>

<package package id="45100105"/>

</header>

<data>

<ppstat RecNum="2">
<dateandtime>2001,1,12,18,17,37,0</dateandtime>
<ipui>40110000E5A97B7F84</ipui>
<dnr>20801</dnr>
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,255</counters>
</ppstat>

</data>

</file>
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